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Legal Notice  

 

Disclaimer 

Wolters Kluwer (UK) Limited has made every effort to ensure the accuracy and completeness 
of this Quick Start Guide.  However, Wolters Kluwer (UK) Limited, its staff and agents will not 
be liable for any errors or omissions and use of the software is subject to the customer’s 
licence with Wolters Kluwer (UK) Limited.  This Quick Start Guide should not be relied upon as 
a detailed specification of the system or the software. 

Wolters Kluwer (UK) Limited may make changes to this Quick Start Guide from time to time. 

 

Copyright 

This Quick Start Guide may not be copied, altered, edited, disposed of or distributed without 
the prior consent of Wolters Kluwer (UK) Limited. The content is confidential.  

Unless indicated otherwise all elements of this software product are owned by Wolters 
Kluwer (UK) Ltd. 

© 2015 Wolters Kluwer (UK) Limited 

 

Trademark Rights 

Microsoft, Windows, Windows NT, Windows for Workgroups, Windows 98, 2000, XP, MS-
DOS, Windows Vista, Windows 7, Windows 8, Windows 10, Windows Server, Microsoft SQL 
Server, and Microsoft Office, are either registered trademarks or trademarks of Microsoft 
Corporation. Novell and NetWare are trademarks of Novell Inc. Citrix MetaFrame is a 
registered trademark or trademarks of Citrix Systems, Inc. All rights reserved.  

All other trademarks are the property of their respective owners. 

Wolters Kluwer (UK) Limited 
145 London Road,  
Kingston Upon Thames,  
Surrey  
KT2 6SR 
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1. Using this Guide 

This guide is designed to prepare you for the introduction of CCH OneClick to your practice, and describes the steps 
you need to undertake to get up and running. It assumes that you are familiar with the Microsoft Windows 
environment, and can perform basic tasks within CCH Central 

There are 3 steps to the CCH OneClick setup 

 

 

 

2. Practice Activation 

▪ Once you have requested that CCH OneClick be added to your licence, you will receive an email guiding you 
through the installation and activation process. 

▪ You will be directed to an activation page where you can activate your practice’s CCH OneClick workspace. 
 

Please note that the activation must be completed by your designated administrator for CCH OneClick 
 
The email address used must NOT be the same as an email address used in CCH Central by an employee that 
you wish to activate for CCH OneClick - If your OneClick administrator will also be a user of CCH OneClick, 2 
different email addresses will be required 

2.1  Online Activation 

▪ The online activation wizard will guide you through the process of activating your practice’s CCH workspace  

2.1.1 Client code & password 

▪ Enter your unique client code and six letter client password, then select Validate credentials 

   

 

 

  

Practice Activation Employee Activation Client Activation 



CCH ONECLICK PRACTICE ACTIVATION & CLIENT SETUP 2 

2.1.2 Domain name 

▪ Based on the credentials you have just entered, a CCH OneClick domain name will be suggested for you 
▪ You can change this suggestion if required, subject to availability 
▪ Select Confirm when you are happy with the name 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪ Read and accept the terms and conditions, then select Continue 

2.1.3 Admin user account 

▪ An admin user profile must now be created to manage your practice’s CCH OneClick workspace 
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• The email address used to setup the administrator account must NOT be the same as an email address used 
in CCH Central by an employee that you wish to active for CCH OneClick  

• If your OneClick administrator will also be a user of CCH OneClick, 2 different email addresses will be 
required 

• Tick to say you have read and agreed to the terms & conditions then continue 

2.1.4 Enter payment details 

▪ Select if you want to pay by direct debit or credit card and enter the relevant details 
▪ If you require more than 1 signatory to setup a direct debit, please contact us directly on +44 (0)344 561 

8181 (option 5 then option 1) 
▪ Select Ok, thanks 

 
 

 

 

  

 

 

 

 

 

 

2.1.5 Activation complete 

▪ Once your payment details have been entered, you will be asked to enter an activation code that you’ll 
receive by email from Bottomline Technologies PT-X Onboarding <ptxo-no-reply@pt-x.com> 

 

 

▪ Once the code is entered your CCH OneClick workspace will be activated! 

mailto:ptxo-no-reply@pt-x.com
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▪ Select Go to OneClick and when prompted use the login details created for the admin account  
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2.2 Link your CCH Central database to CCH OneClick 

▪ To link your CCH Central database to CCH OneClick, select the Connect CCH Central data tile on your 
workspace 

 

 

▪ This will launch a download for an executable file that needs to be run against your CCH Central database 

 

▪ Select the CentralDatabaseInstaller.exe to start the wizard that will guide you through the connection 
process 
 

1. Enter your CCH OneClick credentials used for the activation process above 

 

 
2. Browse to your Central deploy folder and select Run 

 

 

Setup.exe 
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2.3 Customise the CCH OneClick workspace 

▪ Customisation of the workspace will be relected on the workspace that your client sees and not on your 
own practice workspace 

▪ To customise the background and logo, return to CCH Central 
▪ File > Maintenance > OneClick > OneClick Customisation 

  

 

▪ You will then be presented with the OneClick customisation screen 
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▪ Within the OneClick customisation screen you can:- 

→ Enter your practice name 

→ Enter a portal footer, which might be used either for the practice’s promotional strapline or a copyright 

message.  

→ Banner Colour enables you to customise the colour on the banner header on the login page and portal 

which the client sees. You have access to the usual colour palette by clicking the . 

→ If you want to use the custom colour palette, click Define Custom Colours and select your chosen 

colour, clicking Add to Custom Colours when you have the required colour. For lighter shades use the 

hue slider. 

→ Add your practice’s logo – this can be done by selecting browse and locating the image from within your 

files. The recommended size for your logo is 215x60 pixels. 

 

▪ You then have a number of check boxes that allow you to:- 

→ Prompt to send a standard welcome message on activation. When this is selected you will be prompted 

to send an email for both employees and clients once their OneClick workspace has been created. If this 

is not ticked the email will be sent without further input from someone in the practice before sending.  

→ Once the above option is selected, you now have the option to select/unselect the option to save the 

message as a draft. When this is selected, it will save welcome messages as a draft to allow for 

amending prior to sending. When unselected, emails will send automatically.  

→ Draft messages can be found in the Messages & Documents section of the OneClick homepage 

→ Finally, the send reminder emails for documents pending approval option, when selected, will provide 

you with the option for how often a reminder should be sent and the maximum number of times to 

send a reminder email. 

 

2.4 OneClick tab within CCH Central 

▪ From within the CCH Central homepage, you will notice an icon on the ribbon bar for OneClick 

 

▪ Selecting this will load your CCH OneClick workspace in your default browser 
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2.5 Email Templates 

▪ You will now want to review/amend the email templates that will be sent to employees and clients. These 
can be viewed by selecting File, Maintenance > OneClick > Email templates. 

 

 

▪ Once selected, you can view the list of available templates. The templates cover the following:- 

 

 
▪ To open a template, double click on your chosen template, this will open the ‘Edit OneClick Email Template’ 

screen 
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▪ Amend the template as required 
▪ A logo can be added to the email by selecting Picture on the ribbon  

 

 
 

▪ Once you are happy with the content, select OK 
▪ Select OK on the email template list to close 

 

2.6 Set employee (Practice user) permissions 

▪ As with all of the CCH suite, there are user permissions to set for your practice CCH OneClick users to meet 
your internal requirements 
 

▪ User permissions can be found in Maintenance > Security > Task Permissions 
 

▪ Select OneClick from the Product drop down then, for each security group you have created within the 
practice, review and allow permissions as appropriate by ticking the relevant box. Select OK to save changes 
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3. Activate practice employees for OneClick 

▪ Select Employees from the taskbar 

 

 

▪ Once selected, you will be presented with the following message:- 

 

 

▪ Select ‘OK, Got it!’ and tick the ‘Don’t show me again’ button if you’re happy with the content of this screen  
▪ Select ‘Search’ 
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▪ The full employee list will be populated 

 

 

▪ Select the employee(s) you wish to activate 

 

 

▪ Select ‘Activate’ on the ribbon bar 

 

 

▪ The following will then be presented to inform you that the activation has been successful 

 
 

▪ Select OK 
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▪ The employee will now receive an email asking them to click the link to access the login page and enter a 

temporary password 

 

 

▪ Once the link is clicked, a web browser will open and the employee will be asked to enter their email address 
and the temporary password provided in the activation email 

 

 

▪ Once login is selected, the employee will be asked to create a new password 

 

 

▪ Select ‘Continue’ once the new password has been entered 
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▪ The employee will then be presented with the following screen to take them through an introduction to CCH 
OneClick  

 

 

▪ The OneClick dashboard will now be presented and your employee can begin to use their OneClick 
workspace. 
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▪ Upon returning to the employee list, you will notice the employee now has the OneClick icon next to their 
name to signify they are now activated for OneClick. 

 

4. OneClick Permissions Admin 

The latest release includes the option to assign CCH OneClick users to a set of pre-defined roles. The roles allow 
you to control which area of the CCH OneClick suite your users have access to.  

As this is a new feature within CCH OneClick, all users will, by default, be added to the basic roles for all products 

This list is currently limited but will grow with future CCH OneClick releases. 

You can manage the roles for your practice’s CCH OneClick users through the OneClick Permissions Admin tile 
within the admin workspace. 

Note: To access OneClick Permissions Admin, you must log in to your CCH OneClick Admin account. This should 
have been setup when you set up CCH OneClick. (If you didn’t set up an admin account, please navigate to 
https://oneclick.accountantspace.co.uk/activation and follow the instructions to do so) 

 

 

 

Within this area, you will see a list of pre-defined roles into which you can assign your CCH OneClick users 

 
 

https://oneclick.accountantspace.co.uk/activation
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A role defines a set of permissions, so when a user is assigned to a role, they will be given the permissions 
defined within that role. The details of a role can be seen under the description field. 

Note: The permissions within these roles are pre-set and cannot be edited 
 

The current list of roles and description is shown below with a brief explanation of the user experience:- 

Role Name Description Experience 

Data Collection: Basic user 
Access to Data Collection 
functionality 

User will see the Digital Data Request tile in 
CCH OneClick 

Making Tax Digital: Basic 
user 

Access to Making Tax Digital 
functionality excluding VAT 
submissions 

User will see the MTD tile in CCH OneClick, but 
will not see the Submit VAT button within MTD 

Making Tax Digital: 
Advanced user 

Access to Making Tax Digital 
functionality including VAT 
submissions 

Same as the basic user, but the user will see 
the Submit VAT button within MTD 

Messages & Documents: 
Basic user 

Access to Messages & Documents 
functionality 

User will see the Messages and Documents tile 
in CCH OneClick 

Open Integration: Basic 
user 

Access to Open Integration 
functionality 

User will see the Open Integration tile in CCH 
OneClick 

OneClick Payment: 
Administrator 

Access to Payment details 

User will see the Practice Payment information 
tile in CCH OneClick. This should be used for 
employees who are also Practice 
Administrators 

OneClick Permissions: 
Administrator 

Access to OneClick Permissions 
User will see the Permissions Admin tile in CCH 
OneClick. This should be used for employees 
who are also Practice Administrators. 

 

If a user is removed from a basic role, they will no longer have the permissions set by that role. They will also 

lose the ability to view that specific tile within their CCH OneClick workspace 

e.g. If a user is removed from the Messages & Documents: Basic user role, they won’t have permissions to use 

Messages & Documents and they will no longer see the Messages & Documents tile   
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▪ To see which users belong to a particular role, either click the role name or select Edit 

 

 

▪ A list of all users currently assigned to that role will be shown 

 

 

▪ To add a user to the role, select the Add User button 

 

 

▪ Select the box next to the user/s you want to add to the role and click the Add selected users button 
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▪ If there are no users available to add the following message will appear 

 

 

▪ To remove a user from a role, tick the box next to the user/s and select Remove users 

 
 

▪ Users will be subject to their new roles the next time they log in to CCH OneClick 

5. Activate a Client for CCH OneClick 

▪ Once a client has been activated they will be able to access their own workspace within OneClick 
▪ If you would like to inform your clients about CCH OneClick prior to them receiving an activation email, 

please make use of the CCH OneClick flyer on our support site 
https://www.cch.co.uk/softwaresupport/2015/cch_oneclick/get_started.asp 

 
▪ To complete the activation, clients will require an activation code. This is their client code from within CCH 

Central 
▪ If required, the email merge facility can be used to inform clients of their activation code in bulk 
▪ Instructions on how to setup the email merge can be found here 

Text message activation 

▪ There is also the option to send an SMS text message with the Activation ID to clients who have a primary 
mobile phone number set in CCH Central 

▪ This option is called Send Activation ID via SMS and can be found under Maintenance > OneClick > Security 

https://www.cch.co.uk/softwaresupport/2015/cch_oneclick/get_started.asp
https://www.cch.co.uk/softwaresupport/2015/cch_oneclick/docs/cch_oneclick_client_activation_code_email_merge_guide.pdf
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▪ If this option is selected, when a client clicks on the link within the activation email, an SMS containing a 
randomly generated code is sent to the client’s mobile, which they should then enter in the activation page. 
This is sent to the primary mobile phone number set in Central 

5.1 Client Partner 

▪ In order for an employee to activate a client, the client must have a OneClick activated employee set as a 
partner. To do this, select Clients from the ribbon bar 

 

▪ You will be presented with a blank client list and select ‘Search’ 

 

 
▪ The full client list will be populated 

 

 

▪ Select a client and open the ‘Responsibility’ tab 

 

▪ Add a partner that is activated to use CCH OneClick to the client by selecting the  button 
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5.2 Activate a client 

▪ Ensure you are logged in as a user who has the appropriate task permission to activate the client 
▪ Select the checkbox next to the relevant client and select ‘Activate’ 
▪ Multiple clients can be activated at the same time 
▪ The Activate OneClick button can also be found on the ribbon on the Home tab within the client record 

 

▪ Once activate has been selected, the following will be presented 

 

 

▪ The features defaulted on the right hand side are mandatory features and cannot be removed.  
▪ Use the  to move any of the other available features to the right hand side 
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▪ If you have selected the option for a welcome message in the customisation area, you will be presented with 
the following message:- 

 

 
▪ Select Yes to send a welcome message to the client. We recommend you do this so the client knows their 

account has been created 
 

▪ If the following box appears, please wait for this to complete prior to continuing 

 

 

▪ You will then be presented with client activation results, which will confirm the client activation has been 
successful 

 

 

▪ The client will receive an email and will be asked to click the link to access the login page  
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▪ Once the link is clicked, a web browser will open and the client will be asked to enter an activation ID which 
will have been sent to them via SMS. This will only be the case if your practice has chosen to use SMS and the 
client has provided a mobile telephone number 

▪ Alternatively, the activation code will be the client code you use in CCH Central    

 

 

▪ After entering the activation ID a new password should be set 

 

 

▪ The client will be requested to enter the new password twice and then select ‘Continue’ once complete.  
▪ Next, the client will be asked to provide answers to security questions as below, in case the chosen password 

is not remembered 
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▪ Once the answers to the two questions have been provided, select OK to continue. 
▪ They will be presented with the following introduction screen:- 

 

 
▪ After selecting OK, got it, the OneClick dashboard will be presented and your client can begin to use their 

OneClick workspace 

 

5.3 Activate Organisational Clients and Associated contacts 

▪ The process of activating an organisational client is the same as that for an individual client. The only 
difference is for organisations, you will need not only need to activate the organisational client’s workspace, 
but also the users who will have access to it (e.g. the directors); the associated contacts.  

▪ Before activating the workspace for the organisation, please ensure that any anticipated users are listed as 
associated contacts and that they have a current valid email address 

5.3.1 Activation 

▪ Activate the organisation by selecting the Activate OneClick button on the ribbon on the Home tab within 
the client record  
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▪ Select yes to proceed 

 

 

▪ Select the relevant features and click OK 

 

 

▪ From the list of associated contacts, select who will get access to the organisation’s workspace and click OK 
▪ At least one associated contact must be given access to the workspace when activating an organisation 
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▪ Confirm your selection on the following screen:- 

 

 

▪ Select OK 

 

 

▪ Once access has been given to at least one contact, you can then add further features to their CCH OneClick 
workspace if required 
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5.3.2 Associated contacts 

▪ The contact/client will receive an email informing them they now have additional access  
▪ If the contact/client you gave access to is not already activated for CCH OneClick they will receive an 

activation email 
▪ For associated individuals, the same email address will be used to access messages & documents for all 

relationships 

5.3.3 Give access to additional contacts 

▪ If you want to give additional contacts access at a later date, select the OneClick Status hyperlink on the 
Organisation’s associated tab 

 

 

▪ From here, select Enable access to OneClick 

 

 

▪ Choose Yes to enable access 
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▪ Their current status will show on this screen:- 

 

 

5.3.4 Suspend access to CCH OneClick 

▪ If you wish to suspend access to OneClick for a particular client, this can also be done through the OneClick 
features hyperlink within the client record 

 

 

 


